
Pg. 1 
 

PatternCAD Help 
 
PatternCAD is our fully- integrated, full-featured drawing package that enables you to unleash your creativity so you can 
design your own continuous line stitching patterns.  
Designs, such as the one shown here, may look complicated, but with PatternCAD, they are EASY and FUN!  
The features we've put in PatternCAD put you, the Quilting Stitch Pattern Designer, first and foremost. It was 
designed from the ground up for YOU!  
Our core drawing tools are centered on functionality and simplicity. You'll be pleased at the wonderful designs 
you can easily create with PatternCAD.  
PatternCAD Help will walk you through the basics of drawing and editing, then we'll step you though design 
examples that "put it all together" so you'll be quickly up and running with PatternCAD. 
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Introducing PatternCAD  
PatternCAD is our pattern creation tool made especially for Quilters. With PatternCAD, you can make literally 
hundreds of beautiful patterns for your quilts. Let's take a quick tour of PatternCAD then the pattern creation 
fun begins.  
 
 

 
  



Pg. 3 
 

Start PatternCAD  
You have two ways to start PatternCAD, either from the menu bar or from the PatternCAD button. Now let's 
step through the basic areas of PatternCAD Control.  
 
 

 
  



Pg. 4 
 

PatternCAD Menu Bar  
Like QuiltCAD's menu bar, this is a one-stop place to access many of PatternCAD's tools and features.  
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Drawing Mode Box  
We're going to spend a little time on this important box. When using PatternCAD, there are basically two things 
you must do to create your patterns:  
Draw lines.  
Edit lines. This box let's you pick which of the two to do. So why are there 5 buttons? Because, besides drawing 
and editing lines, PatternCAD has a rich set of mirroring tools.  
Not only can you draw and edit lines, but you can also draw and edit mirrors. With mirrors, you can create 
repetition and symmetry in your patterns that will give stunning results. You can also Optimize your drawings 
by reversing lines, showing plot order, and you can remove the trim lines to allow your pattern to be 
continuous.  
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Tool Box  
This area gives you dozens of easy-to-use tools for drawing and editing your lines and mirrors.  
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Quick n EZ  
The Quick N EZ tools are fun and allow you to automatically create literally hundreds of different pattern types.  
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Option Buttons  
These buttons provide different options for you when viewing and drawing your patterns. So.. let's go on to the 
tutorials and let the fun begin!  
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Drawing Lines  
The line is the fundamental part to your pattern designs. After all, isn't a continuous line drawing just a bunch 
of well placed lines?  
PatternCAD allows you to easily draw the lines. But, drawing with a mouse is not quite so easy, is it?  
Don't worry. Once your basic lines are drawn, PatternCAD gives you the ability to precisely move and adjust 
each and every one.  
You'll soon be able to draw wonderful, professional looking continuous line art with PatternCAD's easy-to-use 
interface.  
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Free-hand Sketching  
When PatternCAD first comes up, it's ready to let you draw freehand. Just follow the steps below:  
1.  Position the cursor in the drawing area (initially the grid)  
2.  Hold the Left Mouse button down  
3.  Move (or drag) the cursor  
4.  Release the mouse button. You'll see that you've just drawn bunch of small lines that have red circles 
between each one.  Nothing too revolutionary there, right? Stay with us.  
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Node Spacing  
Those red circles are 'Nodes' and they mark the beginning and end of each line.  Notice that the Node Spacing 
number in the Draw Pattern box is at first set to 4. This number indicates how close the nodes are spaced when 
you free-hand draw. This node spacing does a couple of things for you: It puts down line segments that are all 
nearly the exact same length.  
 
It also provides a built-in smoothing mechanism as you draw. The example below shows the node spacing's of 
1, 4, and 20. By increasing the node space, you will automatically get rid of the "jitter" you usually find in 
computer drawing. On the other hand, the greater the spacing, the less detail you can draw. You'll want to 
experiment and determine what node spacing to use, depending on your drawing. One last thing regarding 
smoothing your drawing, we've built-in yet another tool to make your free hand curves look almost perfect. 
More on that later.  
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No Node Spacing  
This second method of drawing allows you to put down individual lines of any size (that will fit in the displayed 
drawing area). To do this, first turn-off the node spacing (red arrow), then: Position your cursor then hold the 
mouse button down. Drag the cursor to where you want the line to end and release the mouse button. 
PatternCAD will put your line down in the drawing area. 
 
To draw another line, repeat the above process. One nice subtle feature of PatternCAD is that it will 
automatically connect the next line you draw, provided your starting point is near the prior line's ending point.  
 
With this feature, you can be assured your line segments connect perfectly. A very helpful hint.. If you 
accidentally start drawing an unwanted line, just drag the cursor out of the drawing area and the line will 
vanish.  
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The Nodes  
We've talked about the nodes a bit. Here's a little more information.  
Each line segment begins and ends with a node (1). Later on, you'll learn how to move these nodes once your 
lines are drawn.  
The node with the green outline (2) is the starting node of the drawing. The node with the larger red outline (3) 
is the end node.  
These are convenient markers to signal where you should draw your next line (typically at the end node).  The 
red arrow points to a drawing option button that allows you to hide or show the nodes. Often you'll want to 
view your line art without being cluttered by a bunch of little red circles. Click on this button to hide/display the 
nodes.  
 
One last thing.  These nodes do not (necessarily) represent the start and end of stitches. They are strictly for 
drawing and editing purposes. Actual stitching comes much later in the QuiltCAD process.  
 
In PatternCAD, we're first and foremost concerned about your continuous line art.  
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That's it with lines  
Really all pretty simple, right? You can free-hand sketch with node spacing on. You can draw individual lines 
with node spacing off. When free-handing, you can vary the line lengths between the nodes with the node 
spacing number. As we said, drawing with a mouse is not necessarily an easy thing to do. As PatternCAD Help 
continues, we're going to introduce you to more PatternCAD capabilities that will change all that.  
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Arcs, Splines and Parabolas  
Most drawings are made of nice, smooth curves, not line segments. PatternCAD provides three powerful curve 
types to enhance your drawing capability: Arcs, Splines, and Parabolas (shown from top to bottom). (Don't 
worry about that smooshed looking arc. It really is a nice section of a circle. The screenshot we're using to 
illustrate it distorted its true appearance.)  
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Drawing Arcs  
Drawing a perfect section of a circle, begins with drawing a line. But, it's a special line. In the Default Line menu, 
select Arcs.  
Now, just draw the line where you want your arc to start and stop, by positioning and dragging the cursor, just 
like you do for lines with node spacing off.  
Speaking of node spacing, by default, we turn it off when drawing arcs. You can enable it if you want, but we've 
found very little occasion to free-hand place multiple arcs.  
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Prepare to Grow the Arc  
The segment looks just like a regular line. But, it is not. To pull an arc out of that straight line, do the following:  
Get into the edit mode by clicking on Edit.  
Select the entire arc by clicking on the All button.  
Notice that in the middle of the two nodes is a little blue box. It may or may not be solid, either way is OK. This 
blue box is called a HANDLE. To create the arc, you drag the handle. 
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Grow the Arc  
This illustrates how the arc is formed when you drag the handle. To be clear about dragging the handle:  
Place the cursor over the handle  
Hold the left mouse button down  
Move the mouse. The handle will drag, and pull the line segment into an arc. So, drawing an arc is a two-step 
process, and this applies to splines and parabolas as well. First you draw the 'straight' arc just like you would a 
line, (make sure the Default Line Type is Arc.) Second, you get into the edit mode and 'grow' the arc by first 
selecting its nodes and then by dragging the handle. IMPORTANT: If the nodes are not selected, the handles will 
be invisible.  
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Drawing Splines  
The process of drawing splines is the same as drawing arcs. First, let's clear out the drawing space by clicking on 
Clear (1) Make sure you are in the Sketch Mode (2) then.. Select Splines from the Default Line Type Menu (red 
arrow).  
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Draw the Spline Line  
Just like drawing the Arc draw your Spline line with no node spacing.  
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Prepare to Grow the Spline  
Get into the edit mode (1). Select all the nodes (2). Once the nodes are selected, you will see TWO spline 
handles (3).  
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Grow the Spline  
You create the spline curve by dragging the handles. As you drag the handles, the spline will stretch and try to 
follow the handle you're dragging. With splines you can create beautiful curves. Do not underestimate the 
value and power of drawing with splines! Nearly any line drawing can be broken into a series of curves, and 
these curves can be very closely represented by splines.  
 
With the careful placement of a few splines and the proper dragging of their handles, you will be amazed at the 
drawings you can produce.  
Splines are IDEAL for tracing existing drawings you wish to replicate. You'll learn more about PatternCAD tracing 
capabilities later!  
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Drawing Parabolas  
Our last curve is the parabola.  
To set-up for it, clear the drawing (1), get in the sketch mode (2) and select Parabolas as the Default Line Type 
(3).  
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Draw the Parabola Line  
It's the same process as drawing the Arc and Spline lines with the node spacing off.  
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Prepare to Grow the Parabola  
Get in the edit mode and select all the vertices with the All button. The straight parabola line looks identical to 
the Arc line. However, it's not. 
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Grow the Parabola  
Drag the handle, and the parabola line will start stretching towards the handle.  
These three curves along with the straight line provide you with the vital essentials to create your line art.  
We've kept the line types to a minimum, as these curve types can render virtually any shape or drawing you 
want.  
By the way, you don't have to draw one curve, edit it, then draw another, etc. You can go between drawing and 
editing at any time you wish.  
 
Our philosophy in developing PatternCAD is to give you complete control over each and every segment and 
curve that you draw. At no time will we hide or bury your drawing parts into some larger object. You will have 
total control and access to the individual pieces in order to create the perfect 'whole'.  
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Editing Your Drawings  
Drawing your lines is only half the fun. Your pattern design really takes shape after the initial lines are down and 
you start editing them.  
Our pattern of Snickers, clearly shows this.  
 
PatternCAD provides the editing tools so you can move, shape, and re-shape your lines to perfect your artwork.  
 
Unlike drawing on paper, computer drawing with PatternCAD lets you carefully adjust and mold your drawings 
until they are just the way you want. Plus, there's no smudging, crinkled papers, or eraser crumbs!  
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What to Edit?  
For our example, we're going to first draw a simple triangle, then walk you through the edit toolbox to illustrate 
how to use the tools.  
Quickly draw a triangle in the Sketch mode, with node spacing off.  
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Edit Mode  
Click on Edit to get into the edit mode. The Edit Pattern box which contains the edit tools will appear.  
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Selecting Nodes  
In order to edit lines and curves, you must first select the nodes. This can be done in a few different ways.  
Use the All or None buttons to select and unselect all nodes. Notice that when a node is selected, it is solid red. 
When unselected, it is a hollow red.  
Drag a box around the nodes you want to select or unselect. This is done by positioning the cursor, holding the 
left mouse button down, dragging the mouse, and releasing the button. A box will appear as you drag the 
mouse.  
Whatever nodes you enclose within the box will be selected opposite of their current state. That is, if a 
boxed-in node is already selected, it will become unselected, and vice versa.  
 
As you've seen with arcs and splines, in order to adjust the curves, you must select both the nodes at each end 
of the curve you wish to adjust. When both nodes are selected, the blue adjust handles appear. (Our triangle 
has no handles since it is made up of segments).  
 
Once you have the desired nodes selected, the edit tools can be used to operate on those selected nodes.  
 
Let's start editing.  
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Moving a Single Node  
To move a single node, simply position the cursor point directly over it. Hold the left mouse button down and 
drag the node to its new position, then release the button.  
Notice, that to move a single node, the other nodes must first be unselected.  
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Moving Multiple Nodes  
Select several or all the nodes (our example shows all of them selected).  
Position the cursor directly over any selected node, and drag that node to a new position. All nodes that are 
selected will move with it.  
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Inserting and Deleting  
Unselect all the nodes with the None button.  
1.  To Insert:  
2.  Draw a box around one of the nodes to select it, then click on insert. A new segment will appear in place of 
the selected node. We recommend inserting one node at a time.  
3.  To delete: Select one node then click on the Delete button.  
This actually does not delete anything, but breaks the node apart, which is sometimes useful during editing. To 
delete several segments, select several contiguous nodes then click on the Delete button. All the segments 
encompassed by the selected nodes will be deleted.  
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Rotating  
For the next several examples, we'll have you select all the nodes by using the All button. To rotate the drawing 
counter clockwise, click on the Rotate Up arrow. To rotate the drawing clockwise, click on the Rotate Down 
arrow.  
You can change the size of the rotation by incrementing the Step Size with the up and down arrows. The left 
arrows increment in steps of 10, the right arrows do so in steps of 1.  
The Step Size does not perform the rotation, it adjusts the size of rotation in degrees, as well as the size of the 
Scoots and Stretches.  
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Flipping  
Click on the Flip Vertical and Horizontal buttons to flip the selected segments (in this case, the entire drawing 
will be flipped).  
 
 

 
  



Pg. 36 
 

Stretching  
You can stretch your drawing horizontally by clicking on the horizontal pointing stretch arrows. The left arrow 
shrinks the drawing, the right arrow increases its size.  
Stretch the drawing vertically by clicking on the vertical pointing arrows. The '+' and '-' arrows respectively grow 
and shrink the entire drawing both vertically and horizontally.  
A total drawing shrink is shown in (1). A vertical stretch is shown in (2).  
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Scooting  
Besides dragging your selected nodes with the mouse, you can use the Scoot buttons to vertically or 
horizontally move your drawing around the drawing area.  
Remember, you can change the size of the Scoots, Stretches, and Rotates with the Step Size control.  
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Copying  
Select the nodes you want to copy and click on the Copy button. The selected nodes will reproduce and offset 
themselves slightly from the original selections, ready to be dragged or scooted to their new locations.  
PatternCAD's Copy is immediate, it's a copy and paste wrapped into one action.  
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Smoothing (and Simplifying)  
PatternCAD has provided you with a tool to take the rough edges out of your mouse-rendered drawing.  
The drawing below illustrates how the top line, which is rather rough, can be smoothed to give even your 
free-hand sketches a smooth flowing look.  
To Smooth, select only those nodes you want to be smoothed. This is an important and useful concept.  
Sometimes you may want only parts of your drawing to be smoothed.  
In our example, we selected everything but the tip of the wave.  
 
When the smooth button is clicked, everything but that tip will be smoothed. Had we not excluded that node, 
the wave would have become rounded off at the point.  
 
When you compare the top drawing to the bottom, smoothed drawing, the results are rather dramatic.  
 
The Simplify button is used to get rid of several nodes that all lie in the same line, and replace them with a 
single segment. It's probably a feature you won't use much, but it's there if you want to reduce the number of 
nodes while still retaining the shape of the drawing.  
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In Conclusion..  
That's it for the basic editing tools. Again, Cabin Logic has kept the toolset down to the bare essentials. This 
makes it easier to learn, easier to use, and does not clutter up your screen with dozens of controls you don't 
need.  
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Mirrors  
One of PatternCAD's stand-out features is the ability it gives you to mirror your drawings.  
With mirrors that you put down individually, or by using the rich set of pre-defined mirrors, you'll be able to 
create the wonderful artistic effects that come by repetition and symmetry.  
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The Mirrors Mode  
To draw mirrors you have to be in the mirrors mode. This is done by selecting either the Hang button (1) or the 
Adjust button (2). To draw mirrors select Hang.  
To edit mirrors, select Adjust. We gave these buttons these names so as not to confuse them with the Draw and 
Edit buttons used when rendering your patterns.  
Plus, it's like the real world. First, you hang a mirror on a wall, then you adjust its tilt.  
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Hanging (drawing) Your Mirrors  
The technique is identical to that of drawing lines.  
With Node Spacing unchecked, you draw each mirror by left-clicking at the start point, holding the button down 
while you drag the cursor to the end point, and releasing the button. This method allows you to enter mirrors 
of varying sizes.  
With Node Spacing checked, you can lay down mirrors that are pretty much all the same size, with one sweep 
of the mouse while holding the left mouse button down.  
 
You'll notice that the mirrors are green, not to be confused with the black drawing lines.  
The Default Mirror Type is set to Single Sided, which means the mirrors you hang will only reflect drawings on 
one side. If you select Double Sided as the Default Mirror Type, your drawings will be reflected on both sides  
of the mirrors. The next step talks a bit more about drawing with the mirrors. The Forward and Reverse buttons 
allow you to respectively remove the last mirror drawn, or re-add mirrors you've already removed through 
Reverse.  
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Quick Mirrors  
These buttons will automatically put down pre-defined mirrors for you.  
The mirrors shown are from the Horiz 2 button(1). Notice there are two mirrors drawn horizontally that meet in 
the middle.  
When drawing your pattern using these multiple mirrors, start at the center and work out along the Master 
Mirror.  
The Master Mirror is the dark green one. The drawing around the Master Mirror gets copied, or reflected, by all 
the other mirrors.  
NOTE-To draw your lines you need to be in the Sketch mode, and not the Hang mode. Once you have hung your 
mirrors you want to Sketch your lines.  
VERY IMPORTANT! All pattern drawing should be done at the Master Mirror. What you draw at this mirror will 
be reflected at the others.  
Now back to this Quick Mirror. Make sure your drawing ends right at the Master Mirror, to close the loops 
formed by the reflections.  
By the way, all Quick Mirrors are double sided mirrors, even though the Default Mirror Type may indicate 
otherwise.  
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Adjusting Mirrors  
Adjusting Mirrors is much like editing your pattern. First select the Adjust button (1), then select the mirrors 
you want to edit. The picture illustrates selecting nodes by dragging a box around them. You may unselect 
nodes the same way.  
 
 

 
  



Pg. 46 
 

Adjusting Mirrors Continued  
This example illustrates moving the selected mirrors, by holding the left mouse button down on any selected 
node, moving the mouse, and releasing the button.  
You can quickly select all or none of the nodes by using the All or None buttons. The Delete button will remove 
selected mirrors, that is, remove those mirrors whose nodes are selected at both ends. (You cannot delete a 
single node).  
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Changing Mirror Types  
Another capability in the Adjust mode is to change the mirror type, once the mirror is hung.  
You do this by right clicking in the drawing area and selecting which mirror type you want the selected ones to 
be changed to as illustrated by the pop-up menu.  
The Alternating Flipped mirror type will change which side of the mirror the drawing is reflected on, for every 
other mirror.  
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Onward and Upward  
We've now covered the basics of using PatternCAD. There are many more features designed in especially for 
you, the pattern designer. But rather than load you up with more of the nuts and bolts, let's get to some fun 
and produce some real drawings.  
As we start creating drawings together, we'll introduce you to the rest of these powerful and fun features as we 
go.  
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Draw a Feathered Wreath  
OK, let's draw something!  
With essentially one arc, one spline, and PatternCAD's Poly Mirrors, you can draw beautiful feathered patterns.  
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Bring up Poly Mirrors  
In the Quick n EZ menu, select the Poly Mirrors tool. This tool allows you to quickly and accurately lay down 
polygons of mirrors.  
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Set the number of Sides  
Click on the up-arrow (1) to increase the number of Poly Mirror sides to 14. You can actually select however 
many sides you want, even for this example. Once that's done, click on OK (2). Look carefully at the mirrors. 
Notice that one mirror (by the big red arrow) is a darker green. This mirror is the MASTER MIRROR. Whatever 
you draw around the Master Mirror will be copied by the other mirrors.  We scrolled the drawing area a bit (3) 
to move the master mirror closer to the center.  
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Get Ready to Draw  
Select 'Sketch' to get into the drawing mode. Then select the Default Line Type as Splines.  
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Draw 2 Splines  
Starting precisely on the upper corner of the Master Mirror, trace over the Master Mirror, ending at its lower 
corner (1).  
Draw the second spline from the lower corner of the master mirror, towards the center of the drawing (2).  
As you draw these splines, don't let all the other ones that show up bother you. The mirrors are at work, 
copying the drawing at the Master Mirror.  
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Re-trace the Last Spline  
Draw a third spline directly over the last spline drawn. Start at the end closest to the center, and finish at the 
lower corner of the Master Mirror. Why the re-trace? To make this a continuous line drawing. The flow of the 
drawing will start at the top of the Master, go to the bottom of the Master, head towards the center of the 
drawing, and then back out to the bottom of the Master Mirror.  
 
Now, the flow is ready to repeat itself at the next mirror, just below the Master.  
 
This continues on around the Poly Mirrors, until the drawing finishes up where it began, at the top corner of the 
Master Mirror. Another reason for the re-trace: The doubled-over spline can now be edited as a single spline, 
so although there are three splines currently on the drawing, only two actually have to be edited. But what 
about the arc..?  
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Convert one Spline to an Arc  
We could leave the spline that's on top of the Master Mirror, as is.  However, we're going to show you how 
you can change an already drawn line of one type to another. Plus, the arc provides a nice clean way to form 
the outer edges of our feathered wreath. To change the spline, first select Edit, to get into the edit mode (if you 
can believe it, we're already done drawing lines, now it's time to shape them!) Next drag a selection box around 
the Master Mirror corners. You'll see that the corners are now selected red, and the spline handles show up as 
solid blue.  
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Change the Spline  
Hold the right mouse button down anywhere in the drawing. A pop-up menu will appear. Slide down in the 
menu until the Line Type option is highlighted, then another little menu will pop up.  
Keeping the right mouse button down, move the mouse until Arc is selected, and then release the mouse 
button. This changes the outer spline to an arc. See how there is only 1 blue handle now?  
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Shape the Arc  
Now the fun begins. First, select all the vertices by clicking on the All button. Next, click on the Arc handle and 
drag it outwards from the center to where it almost forms a semi circle. See how all the mirrors draw this same 
arc all the way around?  
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Shape the Spline  
Drag the spline handles in the directions shown. The main thing to do is make the curve smooth where the 
spline meets the arc. Just do this by dragging the spline handle that is closest to the arc, until there is a nice 
smooth transition between the arc and spline.  
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Connect the Center  
We're going to move the center node, or end, of the spline, to finish off the tear-drop look and make that nice 
feathered effect.  
To do this, first unselect all the vertices by clicking on the None button.  Next, drag the center node until it just 
touches the spline above it. Remember, as you drag the one node, all the other reflections are going to be 
moving, too. So, you're kind of chasing a moving target to get the end node to touch the adjacent reflected 
spline.  
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Keep the Reflections  
You're all done now, almost.  
Remember, all you've drawn basically is 1 (double) spline and one arc. All those other curves in the pattern are 
just reflections about the mirrors, and don't really exist, yet.  
 
To keep the reflections, click on the Keep Reflections button. The mirrors will disappear, and you'll have the 
finished drawing. To better enjoy the view, you may want to hide the nodes (Click on the Hide Nodes button). 
You can also select the Clear Background from the main menu Background option. There you go. A beautiful, 
continuous line feathered wreath with just a couple of lines, and the power of PatternCAD's Poly Mirrors.  
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So much you can do..  
The Poly Mirrors tool is not just for making feathered wreaths. You can design innumerable closed-loop 
continuous line patterns that are fascinating, intriguing and a pleasure to view and create.  
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Drawing Flakes  
The symmetry of a snowflake has always been a fascinating part of Nature's handiwork.  
With PatternCAD, you too can create intricate flakes, as well as hundreds and hundreds of other delicate, 
symmetrical patterns. We're going to start you off with a simple, freehand snowflake.  
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Select the Flakes tool  
In the Quick n EZ menu, bring up the Flakes tool. Set the number of branches to 6 (this is the initial default 
value). Also make sure the Double Sided Mirrors checkbox is checked. Click on OK to complete the Flake setup.  
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Get set to draw..  
Select the Sketch mode by clicking on the Sketch button. Set the Default Line Type to Segments. Set the node 
spacing to 2, and make sure the Node Spacing checkbox is checked.  
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Draw the flake  
Begin at the very center of the mirrors, and then draw a squiggly pattern from the center to the right along the 
Master Mirror (the darker one).  
As you draw, you'll see the complete flake form before your eyes, as the other mirrors do their magic.  
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Get ready to smooth your drawing  
Your jaggedy line may look a little too jaggedy for your liking. This is not unusual when trying to draw with a 
mouse. Luckily, PatternCAD gives you an easy way to smooth your rough lines. Get into the edit mode by 
clicking on the Edit button. Select all the nodes by clicking on the All button.  
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Smooth the lines  
Click on the Smooth button a few times, until the drawing is smoothed to your liking. If you over-do the 
smoothing, you can undo each one from the Main Menu Edit->Undo option.  
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Keep the reflections and.. OOPS!  
Keep your reflections by clicking on the Keep Reflections button. You may want to hide the nodes by clicking on 
the Hide Nodes button. OK, we have a very subtle problem with our example drawing, one which is common 
and very easy to fix.  
If you look very carefully at the tips of the flakes, they don't touch, there's a slight gap. That's not how a 
continuous line drawing is supposed to be rendered. To help you see this even better, click on the Show Trim 
Lines button. You'll see a tiny blue line between the disconnected tip ends.   
This is a trim line, or a break in the pattern that, when sewn into the quilt, is technically supposed to be cut out.  
These are very tiny in this example and hard to see. Nevertheless, we want to get rid of them. Rather than edit 
each and every point, PatternCAD is again thinking of you, the Quilt Pattern designer.  
Go to the next step to see how eliminate those gaps.  
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Remove the trim lines  
Click on Optimize (1) so you can remove the trim lines that you don't want. Then you will want to Remove All 
Trim Lines (2) . You'll be asked if you want to remove the trim line between the first and last point. Since this 
flake begins and ends at the same place, click Yes. Presto!, the trim lines have vanished, your drawing is whole 
and continuous.  
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Take a better look  
Here's your completed flake.  
Admittedly, this is not an elegant example. But, trust us; you can make some spectacular designs using the flake 
tool.  
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More examples  
Here are just a few samples of the types of things you can do with Flakes. And, they're not all snowflakes, are 
they? The Flake Tool is ideal for drawing those types of items that branch out from the center. And be sure not 
to just freehand your drawing. Use those splines, arcs and parabolas, too!  
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Draw a Leaf  
With a few splines, draw a simple, realistic looking leaf.  
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Get set to draw..  
Make sure you are in the Sketch mode, and set the Default Line Type to Splines.  
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Draw the splines  
This only requires 8 splines. Going from left to right, draw the splines as shown in the example.  
Your drawing does not have to exactly match the example, just follow the basic outline.  
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Begin shaping the lines.  
Get into the edit mode (1). Then individually drag the nodes at the base of the leaf into 1 point.  
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Shape the base of the leaf  
First, select all the nodes by clicking on the All button. Drag the lower handles of the leaf's base splines inward 
just a bit. Then drag the upper handles out a ways to give the base of the leaf a smooth curve.  
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Shape the top of the leaf  
Drag the lower handles of the top splines outward a bit to make the curves between the upper and lower half 
of the leaf smooth. Pull the upper spline handles inwards, just under the leaf point. This should give you a good 
basic outline of a generic leaf.  
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Adjust the leaf spine.  
This is really simple. First unselect all the nodes by clicking on the None button (1). Then, simply drag the upper 
end of the spline up towards the tip of the leaf. The spline, in this case, will have a natural curve that you 
probably don't even need to adjust.  
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Shape the twig  
Select just the nodes that make up the twig.  
Drag the ends of the twigs and the spline handles to make the twig look like a natural part of a plant. That is all 
there is to it. You now have a full-fledged leaf. However, we're going to take this even further. We're going to 
show you how to create a branch full of leaves from this single leaf.   
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Set up for Mirroring  
We're going to use mirrors to replicate the leaves. Get into the mirror drawing mode by clicking on the Hang 
button. Also, zoom out and scroll over to position your leaf in the left side of the drawing area. (These steps do 
not have to be done in any particular order; just make sure you do them all)  
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Draw your mirrors  
The first mirror is the most critical. Make sure it starts at the left end of the twig and ends precisely on the right 
end of the twig (1). This is the Master Mirror. All subsequent mirrors will copy the drawing (the leaf, that is) that 
is drawn about the Master Mirror. Continue drawing more mirrors, as many as you wish. In our example we've 
drawn a total of 10. Notice that the new leaves will follow the slant of the new mirrors. Also, the leaves will 
scale to the size of the new mirrors.  
 
If you want smaller leaves, draw smaller mirrors. If you want larger leaves, draw the new mirrors larger than 
the Master Mirror. To make sure this is a continuous line drawing, draw the new mirrors so they touch each 
other end to-end.  
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Prepare to flip the leaves  
This branch looks a bit unnatural with all the leaves on one side. We're going to flip every other one to the 
opposite side of the branch, to improve its appearance.  First, get into the mirror edit mode by clicking on the 
Adjust button. Next select all the mirror nodes.  
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Flip the leaves  
Right click in the drawing area to bring up the pop-up menu.  
With the right mouse button down, select the menu item Mirror Type -> Alternating Flipped, then release the 
button. Now, every other leaf is on the opposite of the branch.  
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Keep the reflections  
Click on the Keep Reflections button to remove the mirrors and keep the reflected leaves.  
To make the view more clear, click on the Hide Nodes button, and if you wish, select the Clear background from 
the Background Main Menu item.  
Now you have a natural, organic-looking branch of leaves that is a good basis for (among other things) a quilt 
border.  
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Using the Layers  
PatternCAD has two layers you can use when rendering your drawings.  We've made it as simple as possible. 
The top layer is where you do your drawing. The bottom layer is where you can store parts of your drawing, and 
later bring them back to the top. As shown in the picture below, the contents of the bottom layer are always 
visible and drawn in blue. The nodes are never visible in the bottom layer. Using the bottom to temporarily 
store your partial designs is useful in a number of ways. In a particularly complex drawing, you can put the 
completed portions in the bottom layer, and continue with your drawing in the top. It removes a lot of clutter 
from the screen and improves the performance of PatternCAD.  
If you want to use mirroring in part of your drawing, put the non-mirrored part in the bottom layer, draw with 
the mirrors on top, then merge the bottom back with the top (AFTER you keep your reflections!)  
You can also easily merge completed designs by storing the first in the bottom layer, then reading in a second 
to the top. This may be repeated any number of times to combine several patterns into one.  
We'll explain the four ways you can move the drawings amongst the two layers, and then walk you through a 
quick example of their use.  
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The Layers Menu Items  
To use the Layers feature, simply select your desired Layer action from the Main Menu Layers option. Below is 
an explanation of these Layer actions:  
 
Copy to Bottom Layer It copies the entire top layer to the bottom. Whatever was in the bottom layer is 
overwritten by the top layer. The drawing remains in the top layer, too.  
 
Swap Layers It moves the bottom layer drawing to the top, and vice versa.  
 
Merge Bottom to Top This combines the bottom layer with the top, and brings it all to the top. The top drawing 
is actually appended to the bottom drawing before they are brought-up. This is done to preserve the order you 
drew the design, with the oldest parts of the drawing being placed first in the merge.  
 
Merge Top to Bottom This appends the top layer to the bottom and places the merged drawings on the bottom 
layer. Again, the plot (or drawing) order is preserved by appending the top with the bottom.  
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An Example with Layers  
Now, let's quickly go through a fun example that uses the Layers feature. From the Quick n EZ menu, select the 
Poly Mirrors (1) and increment the number of sides to 5 (2).  
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Sketch a Spline  
In the Sketch Mode (1), select Splines (2) as the Default Line Type and draw a single spline directly over the 
Master Mirror (3).  
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Shape the Spline  
Now, in the Edit Mode (1), drag the spline handles (2) to create a neat looking 5-pointed design.  
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Keep and Copy  
Keep the reflections (1) and copy the top layer to the bottom by using the Main Menu selection of Layers -> 
Copy to Bottom Layer.  
Although you can't tell at this point, the bottom layer has an exact replica of the top image, directly under the 
top image.  
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Flip the Top  
Select all the nodes (1) and then click on the Flip Vertical button.  
Now you can see the bottom layer at work, and it creates a rather intriguing design by doubling the initial one, 
doesn't it?  
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Merge the Layers  
From the Main Menu, select Layers -> Merge Bottom to Top. Now your two layers become one, and you have a 
completed double design.  
(We turned off the nodes and set the background to Clear).  
In the PatternCAD Gallery, we created the ribbon patterns through a series of such actions, using Poly Mirrors 
and successively shrinking and merging the basic shape.  
If you're careful, you can have each copy start and end at the same point, and thus maintain your continuous 
line drawing, no matter how many copies you make and merge.  The more experienced you get with 
PatternCAD, the more you'll appreciate the ability to draw with the Layers.  
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Tracing Power  
Another powerful PatternCAD feature is the ability to load in pictures as the background, so you can trace over 
them. You'll be able to trace children's profiles, animals, flowers, anything! Our Snickers pattern was traced. 
Tracing will allow you to bring your continuous line art to a whole new level, and allow you to personalize your 
stitching in ways you may have not thought possible.  
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Set the Background  
We've touched on this topic before, now we're going to go into more detail. PatternCAD has basically three 
background types as shown in the drop-down menu: Clear, Grid, and Picture (with Load). It is the Picture 
background you use when tracing. Before we get to tracing, go ahead and select Clear and Grid to see the 
background change using the first two Background Options.  
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Loading a Picture Background  
To set a picture as a background, select from the Main Menu Bar: Background -> Load.  
A 'Load Background' dialog box will pop-up allowing you to navigate to and select the picture of your choice. 
PatternCAD currently allows two picture formats: Bitmaps and JPEGs. Find and select the picture you want, 
then 'Open' it. PatternCAD will center the picture in the middle of the drawing area. What PatternCAD won't do 
is resize the picture, because it's not meant to be a photo editor.  However, we do provide a few options that 
allow you to modify the picture to make tracing easier.  
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Modify the Background  
Some pictures are difficult to trace, because of their colors and shading.  
PatternCAD has three different methods you can apply to the background that may make the tracing job a bit 
easier.  
Fade For those photos that are very dark, you can successively fade them out. This can make seeing your 
tracing lines easier. Select from the Main Menu Bar: Backgrounds -> Fade  
 
Gray Scale (BW) Sometimes, a black and white drawing is easier to trace. To convert the picture to Black and 
White, Select from the Main Menu Bar: Backgrounds -> Gray Scale (BW)  
 
Invert You can also invert the background to show its negative image. Select from the Main Menu Bar: 
Backgrounds -> Invert We use Fade the most. By the way, you cannot undo a background modification like 
Fade. If you Fade it too far, you'll just have to re-load the picture.  
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Tracing Kevin  
First, load in the 'KevinAndAmie' Picture, using the Background -> Load option. We've panned over to Kevin and 
faded the picture a bit. We're going to walk you through tracing Kevin, to show you how quick and easy it is.  
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Start Tracing  
Most tracing can be effectively rendered with splines. Of course, this depends on what you're tracing; 
sometimes arcs and lines will work better.  
 
In the Sketch Mode, select Splines as the Default Line Type.  
 
Initially, your straight splines will look very little like the actual picture. But don't worry, they soon will.  Start 
at the right and draw your first spline.  
 
Now, here is THE KEY to correctly placing splines:  
 
LOOK FOR SINGLE, GENTLE SLOPING ARCHES on the picture's outline.  
 
Then draw the spline from one end of the arch to the other.  
 
Although our splines can form a double arch by pulling the handles in opposite directions, you will have MUCH 
better success by only creating a single arc with the spline.  
 
Also, do not try to cover a steep arch with a single spline. Break it into a few smaller arches with separate 
splines. The arrows clearly show that the contour of Kevin's head is divided into three sections, and each 
section constitutes a single arc and that each arc will be rendered by a single spline.  
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Stretch the Splines  
Once you've laid down a few (or even all) splines, get into the Edit Mode, select the splines you wish to edit, 
then pull the handles until the lines lie over the picture's outline.  
That's really all there is to it. It takes a little patience, but the results will be excellent.  
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On to the Details  
You'll probably want to zoom-in to do the facial features. But the same principle applies, one spine per single 
curve.  
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Shape the Details  
In the edit mode, carefully pull the handles so the spline curves line up with the facial curves.  
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Here's Kevin  
This is what a finished Kevin looks like, fully splined.  
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Kevin's Outline  
And here's Kevin's outline with no background and no nodes. With only 15 well-placed splines we have 
rendered a near-perfect profile of Kevin.  
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And Amie, too  
We don't want to leave Amie out. Here she is fully lined with straight splines. Notice this time we didn't fade 
the background, but are using a yellow line.  
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Amie Splined  
Here's Amie after the splines have been stretched. (We 'fixed' her hair a bit on her forehead)  
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Amie's Outline  
The completed, continuous line profile of Amie.  
With tracing pictures such as these, your quilt stitching can be more personal than ever before.  
Plus, on your quilts, you can capture your special people at specific points in time that will endure for years.  
And lastly, when doing such tracing, you'll begin to see those little curves, and features on your loved ones that 
you may have never really noticed before, yet it's what makes them special and who they are.  
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Optimize & Options  
By now, you are probably getting quite proficient at drawing patterns with PatternCAD.  
Let's learn about some more features that have been developed specifically for you, the machine quilting artist.  
These useful features, that assist you in developing perfect, continuous line art, are located under Optimize in 
the Drawing Mode Box.  
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Remove Trim Lines Many times when drawing line segments, you may accidentally not connect them to form a 
continuous pattern.  
The drawing below is an over-exaggeration that illustrates this. Notice at 1, the two nodes do not connect. 
When the Show Trim Lines button is in, you can clearly see the blue trim line in the gap between the two nodes.  
When you are actually sewing, particularly with a computer controlled system, you would not want this.  
To remove the gap, you may edit the nodes and drag them over to each other, or u se the Remove  
Trim Lines menu option. Do this by selecting the nodes and then selecting Optimize -> Remove Trim Lines. 
PatternCAD will automatically do the editing for you and join the two nodes (2)! It is a good practice to select all 
the nodes and perform this action to ensure there are no trim lines. If you do select all the nodes, you will be 
prompted whether to join the first and last nodes together. Only say Yes to the prompt if you want the first and 
last nodes to be at the same spot. Otherwise, say no.  
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Reverse Plot Order  
 
There are times when you'll find it necessary to reverse some or all of your pattern's plot order. When drawing 
your patterns THINK LIKE A SEWING MACHINE! The Plot Order is the path your machine will follow when 
sewing the pattern, especially if you use computer control. Therefore, you must always keep in mind the path 
you want your machine to follow. Our two patterns below clearly illustrate a non-optimized and optimized Plot 
Order. The three lines were made by copying the first one. The trim lines on the top (1) show a 'typewriter' type 
sewing path. Assuming a computer controlled machine, the path starts left and goes right on the top line. 
However, when it reaches the end, the machine does a 'carriage return' and returns to the left before it starts 
sewing again. This is repeated for the third line, too. To solve this poor sewing path, simply select that portion 
of the pattern where you would like to have the machine move from right to left. In this case it is the middle 
line of nodes. Once the nodes are selected, use the Optimize -> Reverse Plot Order menu option. Figure (2) 
shows the result of this action. Now the machine follows a nice, continuous 'S' pattern to render the same 
drawing. At this point, you can easily remove the two trim lines by inserting connecting segments. The Reverse 
Plot Order (All) is particularly useful when you have drawn a pattern, and then realize you need to add some 
lines at the beginning of the drawing. Simply perform the Reverse Plot Order (All) and the beginning will 
become the end (the large green and red endpoint nodes swap places). Add your lines at the 'end' (large red) 
node, then do the Reverse Plot Order (All) once again, and there you have it, your new lines are now at the 
beginning of the drawing. We've talked a lot about plot order here. It's not so critical if you are printing out 
your patterns to follow with a stylus, because you can easily see where the machine should best travel. 
However, it is very important when using computer controlled sewing machines, because computers are not as 
bright as we humans. They must be told EXACTLY where to go, they are not good at deciding for themselves. It 
is a good practice to always render your drawings in the plot order you want your sewing machine to follow. 
And, that is in a general Left-to-Right flow (unless of course, the drawing is a closed loop). Use the Optimize -> 
Show Plot Order option to see your plot flow (or machine sewing path).  
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Options  
Most of the Main Menu Bar Options selections have been covered elsewhere in PatternCAD help. This just 
provides another means to select these options. One feature you may enjoy is the ability to change your line 
colors. This applies not only to the drawing lines but to the mirrors also. It can come in handy, particularly when 
you are tracing photographs and the default line color (dark gray) may not show up very well.  
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Tools  
PatternCAD gives you tools that you can apply to your drawings to achieve some fun, intriguing effects.  
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Triangle Templates  
To draw triangle patterns to be used in QuiltCAD's Triangle Blocks, we have provided you with three different 
templates.  
Which template you use, depends on the type of symmetry you wish to achieve within the triangle pattern you 
draw.  
The templates consist of a triangle drawn on the bottom layer, and zero to two mirrors.  
The bottom layer triangle is just used as an outline; it is not to be merged with your finished drawing.  
 
The arrows within the templates shown to the left indicate the direction of the drawing flow, which is 
Left-to-Right.  
 
For those templates with mirrors (2 and 3), make sure your drawing ends on the leftmost mirror, so the 
reflections will be properly connected.  
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Drawing a Triangle Pattern  
Once you have a template pulled up, drawing intricate, fascinating triangle patterns is a snap.  
Our example uses Triangle Template 3, the one with the two mirrors. Below are the steps to creating our 
pattern:  
We drew four arcs in the lower left triangle of the template.  
Then we stretched the arcs, and moved a node or two as shown in drawing.  
Here is the pattern after we keep the reflections.  
Here is the pattern as it would look in QuiltCAD with the Criss-cross Triangle blocks selected. In a matter of a 
couple of minutes, you will be astonished at the beautiful stitch patterns you can create using the Triangle 
Templates.  
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Group Effects  
The Group Effects set of tools let you re-shape your entire patterns into really interesting shapes.  
To use them, first select all the nodes in the Edit mode, then select the Tools -> Group Effects menu option. The 
Group Effects tool box will appear on the right edge of PatternCAD. From the tool box, select which Effect you 
want. A box will be drawn around your pattern, and the pattern will be rendered in purple. Below describes 
how to use the three Group Effects:  
Stretch - The blue handles will stretch or shrink your pattern horizontally or vertically.  
Distortion Lines - By dragging the corner nodes of the box, you can apply slants to the overall shape of your 
pattern.  
Distortion Splines - By dragging the handles, you can apply curves to your pattern.  
 
Once you've reshaped your drawing to your liking, click on Apply to keep the reshape, or OK to keep the 
re-shape and exit the Group Effects tool.  
The Group Effects work most predictably on line based patterns. Arcs, splines, and parabolas do not always 
re-shape as expected. Also, the more nodes in the pattern, the more the pattern will follow the contour of the 
Group Effects lines.  
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Matrix  
Matrix provides a quick way to repeat your patterns.  
Once you select the matrix option, the Matrix tool box will appear. You can select how many rows and columns 
you want your pattern to repeat in.  
Also, you can space the patterns by clicking on the spacing arrows, if you don't want the patterns to butt-up 
against each other.  
This tool uses mirrors to create the copying. When you are satisfied with the number of rows and columns, click 
on OK in the Matrix tool box. You can then edit the drawing if desired.  
Then to keep the entire Matrix, be sure to click on the Keep Reflections button, otherwise the reflections will go 
away. You may then save your pattern.  
 
Be careful with using the Matrix tool. It is a very easy way to complicate your design and to create trim lines and 
bad plot orders.  
 
However, it is a powerful way to quickly repeat your pattern if that is what you desire.  
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End Point Continuity  
This is a great little feature that allows you to ensure your pattern, when repeated in the Quilt, will have its end 
points line up perfectly. We've brought in our duck pattern, and purposefully moved the right end point to 
illustrate this. We then selected Tool-> End Point Continuity from the Tool Menu Bar.  
 
What this feature does is draw two mirrors at the beginning and end of the pattern. It reflects the pattern on 
either side of the mirrors, to show you if the end points align or not. In our duck example, clearly there is a 
major break between the end points. In the edit mode, you can select the end points and move them until they 
align perfectly to your satisfaction.  
 
Then, save the pattern, but DO NOT SAVE THE REFLECTIONS when prompted. Just save the pattern. Now the 
pattern is ready to be placed in the quilt blocks and their end points will line up perfectly.  
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Quick n EZ  
PatternCAD can create literally hundreds and hundreds of patterns for you automatically. The Quick n EZ menu 
is where you go to make these patterns. You've already learned how to use two of these pattern types: Flakes 
and Poly Mirrors. We shall now introduce you to the rest.  
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Spirals  
With the Spirals, you can create beautiful spiral patterns, just like the ones you may have made with Spiral 
Graph, on paper. Bring up the Spirals option from the Quick n EZ menu, and the Spirals tool box will appear. To 
create the spiral patterns, just click on the Spirals and Radius buttons, then PatternCAD will do the rest.  
 
There are, to be precise, 1800 unique spiral patterns you can create by varying the radius and number of 
spirals! WARNING! When you bring up Spirals, it will clear out any pattern that was already present. Be sure to 
save the pattern first, if you want, or copy it down to the second layer, if you want to later merge the spiral with 
the pattern.  
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Hilberts  
Hilberts is a space-filling pattern. When you bring it up, it will display a bunch of mirrors. The Master Mirror is 
the top left mirror, as the red arrow indicates. You can increase the number of mirrors with the Level button, 
which ranges from 1 to 5.  
Once you have the number of mirrors you want, click OK in the Hilberts tool box. Then you can go to the Sketch 
mode, and draw your line(s) about the Master Mirror, and view the resulting space filling pattern.  
Remember to save your reflections when you're done.  
The Randomize slider control scrambles up the Hilbert Mirrors corners, to vary the pattern. The higher the 
Randomize number, the more scrambled the nodes become. The next slide shows a few examples of Hilberts.  
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Hilbert Examples  
We'll briefly explain how each Hilbert pattern was made.  
Top Left This is a level 3 Hilbert, using an arc on the Master Mirror. Before drawing the arc, we selected all the 
Mirrors and changed the mirror type to Alternating. If you forgot how to do this, go back to the lesson on  
 
Mirrors. Top Right This is a level 5 Hilbert, using a single segment on the Master Mirror.  
 
Bottom Left This is a level 4, using and adjusting a single spline at the Master Mirror.  
Bottom Right Another level 4 Hilbert with a little Randomize thrown in. Also, we sketched with line segments, 
then did a few Smoothings.  
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Bowditches  
Bowditches are interesting patterns based on mathematical equations. The Bowditch Tool Box provides you 
with three sets of controls whose values each range from 1 to 16.  
Experiment with the buttons and see the fascinating patterns that arise. Although there are a total of 4096 
different combinations of values these buttons can make, you'll find many of the Bowditches repeat 
themselves.  
Also, every Bowditch pattern is a closed loop, even the example shown in the top right corner. The math is such 
that the pattern traces back over itself until it gets back to where it started.  
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Polygons  
You can quickly create polygons that have from 3 to 50 sides.  
When you bring up the Polygon tool box, the polygon will be rendered in purple, but it is NOT a part of your 
drawing until you click on OK. The purple polygon will go away if you should try and do some other PatternCAD 
function, without first okaying it.  
Once a polygon is drawn and OK'd, it appends itself to the existing pattern, without destroying what you 
already have.  
Plus, all the nodes are selected when you OK it, thus making it ready to move, rotate, resize, et cetera.  
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Circles, Arcs and Elipses  
You've probably noticed by now that there is no tool for making Elipses or Circles. Well, actually there are several ways to 
do this. To make a circle, make a 50 sided polygon, you'll see it forms quite a nice circle. You can easily make an elipse 
from the circle by stretching the circle in a single direction. The top left drawing shows this. The top right drawing 
illustrates an eliptical arc that was made by deleting the bottom half of the elipse. 
 
You can do other things with these polygon-made circles, too, like the pie-slice looking thing on the lower left. This was 
done by deleting some of the circle's nodes and adding two segments.  
 
Lastly, you can distort the shape of the polygon-made circle using the Group Effects tools. This distortion cannot 
be done on an arc made with the arc line type. That is because that arc line type is defined by two end points 
and the handle that was used to stretch the arc. The polygon-made arc, though, is really just a bunch of little 
lines whose nodes you can manipulate individually or as an entire group.  
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That's All!  
You have now been instructed on the main points of using QuiltCAD and PatternCAD.  
Embedded in the simplicity of using these tools is a lot of power to enable you to create beautiful line art that 
will eventually be forever captured in your quilts. Have fun designing and drawing and let us know how it goes. 
We'd love to hear from you!  
 
 

 
 


